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Ashtech Products - Limited Warranty (North, Central 

and South America)

Ashtech warrants their GPS receivers and hardware 
accessories to be free of defects in material and 
workmanship and will conform to our published 
specifications for the product for a period of one year 
from the date of original purchase. THIS WARRANTY 
APPLIES ONLY TO THE ORIGINAL PURCHASER OF 
THIS PRODUCT. 

In the event of a defect, Ashtech will, at its option, 
repair or replace the hardware product with no charge 
to the purchaser for parts or labor. The repaired or re-
placed product will be warranted for 90 days from 
the date of return shipment, or for the balance of the 
original warranty, whichever is longer. Ashtech war-
rants that software products or software included in 
hardware products will be free from defects in the 
media for a period of 30 days from the date of ship-
ment and will substantially conform to the then-cur-
rent user documentation provided with the software 
(including updates thereto). Ashtech's sole obliga-
tion shall be the correction or replacement of the me-
dia or the software so that it will substantially 
conform to the then- current user documentation. 
Ashtech does not warrant the software will meet pur-
chaser's requirements or that its operation will be un-
interrupted, error-free or virus-free. Purchaser 
assumes the entire risk of using the software.

PURCHASER'S EXCLUSIVE REMEDY UNDER THIS 
WRITTEN WARRANTY OR ANY IMPLIED WARRAN-
TY SHALL BE LIMITED TO THE REPAIR OR RE-
PLACEMENT, AT ASHTECH'S OPTION, OF ANY 
DEFECTIVE PART OF THE RECEIVER OR ACCESSO-
RIES WHICH ARE COVERED BY THIS WARRANTY. 
REPAIRS UNDER THIS WARRANTY SHALL ONLY 
BE MADE AT AN AUTHORIZED ASHTECH SERVICE 
CENTER. ANY REPAIRS BY A SERVICE CENTER 
NOT AUTHORIZED BY ASHTECH WILL VOID THIS 
WARRANTY.

To obtain warranty service the purchaser must obtain 
a Return Materials Authorization (RMA) number prior 
to shipping by calling 1-800-229-2400 (North 
America) or 1-408-572-1134 (International) and 
leaving a voice mail at option 3, or by submitting a 
repair request on-line at: http://ashtech.com (fill out 
the RMA request from under the Support tab). The 
purchaser must return the product postpaid with a 
copy of the original sales receipt to the address pro-
vided by Ashtech with the RMA number. Purchaser’s 
return address and the RMA number must be clearly 
printed on the outside of the package.

Ashtech reserves the right to refuse to provide service 
free-of-charge if the sales receipt is not provided or if 
the information contained in it is incomplete or illeg-
ible or if the serial number is altered or removed. 
Ashtech will not be responsible for any losses or dam-
age to the product incurred while the product is in 
transit or is being shipped for repair. Insurance is 
recommended. Ashtech suggests using a trackable 
shipping method such as UPS or FedEx when return-
ing a product for service.

EXCEPT AS SET FORTH IN THIS LIMITED WAR-
RANTY, ALL OTHER EXPRESSED OR IMPLIED 
WARRANTIES, INCLUDING THOSE OF FITNESS 

FOR ANY PARTICULAR PURPOSE, MERCHANT-
ABILITY OR NON-INFRINGEMENT, ARE HEREBY 
DISCLAIMED AND IF APPLICABLE, IMPLIED WAR-
RANTIES UNDER ARTICLE 35 OF THE UNITED NA-
TIONS CONVENTION ON CONTRACTS FOR THE 
INTERNATIONAL SALE OF GOODS. Some national, 
state, or local laws do not allow limitations on im-
plied warranty or how long an implied warranty lasts, 
so the above limitation may not apply to you.

The following are excluded from the warranty cover-
age: (1) periodic maintenance and repair or replace-
ment of parts due to normal wear and tear; (2) 
batteries and finishes; (3) installations or defects re-
sulting from installation; (4) any damage caused by 
(i) shipping, misuse, abuse, negligence, tampering, 
or improper use; (ii) disasters such as fire, flood, 
wind, and lightning; (iii) unauthorized attachments 
or modification; (5) service performed or attempted 
by anyone other than an authorized Ashtechs Service 
Center; (6) any product, components or parts not 
manufactured by Ashtech; (7) that the receiver will 
be free from any claim for infringement of any pat-
ent, trademark, copyright or other proprietary right, 
including trade secrets; and (8) any damage due to 
accident, resulting from inaccurate satellite trans-
missions. Inaccurate transmissions can occur due to 
changes in the position, health or geometry of a sat-
ellite or modifications to the receiver that may be re-
quired due to any change in the GPS. (Note: Ashtech 
GPS receivers use GPS or GPS+GLONASS to obtain 
position, velocity and time information. GPS is oper-
ated by the U.S. Government and GLONASS is the 
Global Navigation Satellite System of the Russian 
Federation, which are solely responsible for the accu-
racy and maintenance of their systems. Certain con-
ditions can cause inaccuracies which could require 
modifications to the receiver. Examples of such con-
ditions include but are not limited to changes in the 
GPS or GLONASS transmission.)  Opening, disman-
tling or repairing of this product by anyone other than 
an authorized Ashtech Service Center will void this 
warranty.

ASHTECH SHALL NOT BE LIABLE TO PURCHASER 
OR ANY OTHER PERSON FOR ANY INCIDENTAL OR 
CONSEQUENTIAL DAMAGES WHATSOEVER, IN-
CLUDING BUT NOT LIMITED TO LOST PROFITS, 
DAMAGES RESULTING FROM DELAY OR LOSS OF 
USE, LOSS OF OR DAMAGES ARISING OUT OF 
BREACH OF THIS WARRANTY OR ANY IMPLIED 
WARRANTY EVEN THOUGH CAUSED BY NEGLI-
GENCE OR OTHER FAULT OFASHTECH OR NEGLI-
GENT USAGE OF THE PRODUCT. IN NO EVENT 
WILL ASHTECH BE RESPONSIBLE FOR SUCH 
DAMAGES, EVEN IF ASHTECH HAS BEEN ADVISED 
OF THE POSSIBILITY OF SUCH DAMAGES.

This written warranty is the complete, final and ex-
clusive agreement between Ashtech and the pur-
chaser with respect to the quality of performance of 
the goods and any and all warranties and representa-
tions. This warranty sets forth all of Ashtech's respon-
sibilities regarding this product. This limited 
warranty is governed by the laws of the State of Cali-
fornia, without reference to its conflict of law provi-
sions or the U.N. Convention on Contracts for the 
International Sale of Goods, and shall benefit 
Ashtech, its successors and assigns.

This warranty gives the purchaser specific rights. The 
purchaser may have other rights which vary from lo-
cality to locality (including Directive 1999/44/EC in 
the EC Member States) and certain limitations con-
tained in this warranty, including the exclusion or 



limitation of incidental or consequential damages 
may not apply. 

For further information concerning this limited war-
ranty, please call or write:

Ashtech SAS - ZAC La Fleuriaye - BP 433 - 44474 
Carquefou Cedex - France  Phone: +33 (0)2 28 09 
38 00, Fax: +33 (0)2 28 09 39 39.

Ashtech Products Limited Warranty (Europe, Middle 

East, Africa)

All Ashtech global positioning system (GPS) receiv-
ers are navigation aids, and are not intended to re-
place other methods of navigation. Purchaser is 
advised to perform careful position charting and use 
good judgment. READ THE USER GUIDE CAREFUL-
LY BEFORE USING THE PRODUCT.

1. ASHTECH WARRANTY

Ashtech warrants their GPS receivers and hardware 
accessories to be free of defects in material and 
workmanship and will conform to our published 
specifications for the product for a period of one year 
from the date of original purchase or such longer pe-
riod as required by law. THIS WARRANTY APPLIES 
ONLY TO THE ORIGINAL PURCHASER OF THIS 
PRODUCT. 

In the event of a defect, Ashtech will, at its option, 
repair or replace the hardware product with no charge 
to the purchaser for parts or labor. The repaired or re-
placed product will be warranted for 90 days from 
the date of return shipment, or for the balance of the 
original warranty, whichever is longer. Ashtech war-
rants that software products or software included in 
hardware products will be free from defects in the 
media for a period of 30 days from the date of ship-
ment and will substantially conform to the then-cur-
rent user documentation provided with the software 
(including updates thereto). Ashtech's sole obliga-
tion shall be the correction or replacement of the me-
dia or the software so that it will substantially 
conform to the then- current user documentation. 
Ashtech does not warrant the software will meet pur-
chaser's requirements or that its operation will be un-
interrupted, error-free or virus-free. Purchaser 
assumes the entire risk of using the software.

2. PURCHASER'S REMEDY

PURCHASER'S EXCLUSIVE REMEDY UNDER THIS 
WRITTEN WARRANTY OR ANY IMPLIED WARRAN-
TY SHALL BE LIMITED TO THE REPAIR OR RE-
PLACEMENT, AT ASHTECH'S OPTION, OF ANY 
DEFECTIVE PART OF THE RECEIVER OR ACCESSO-
RIES WHICH ARE COVERED BY THIS WARRANTY. 
REPAIRS UNDER THIS WARRANTY SHALL ONLY 
BE MADE AT AN AUTHORIZED ASHTECH SERVICE 
CENTER. ANY REPAIRS BY A SERVICE CENTER 
NOT AUTHORIZED BY ASHTECH WILL VOID THIS 
WARRANTY.

3. PURCHASER'S DUTIES

To obtain service, contact and return the product 
with a copy of the original sales receipt to the dealer 
from whom you purchased the product.

Ashtech reserves the right to refuse to provide service 
free-of-charge if the sales receipt is not provided or if 
the information contained in it is incomplete or illeg-
ible or if the serial number is altered or removed. 
Ashtech will not be responsible for any losses or dam-
age to the product incurred while the product is in 
transit or is being shipped for repair. Insurance is 
recommended. Ashtech suggests using a trackable 

shipping method such as UPS or FedEx when return-
ing a product for service.

4. LIMITATION OF IMPLIED WARRANTIES

EXCEPT AS SET FORTH IN ITEM 1 ABOVE, ALL 
OTHER EXPRESSED OR IMPLIED WARRANTIES, 
INCLUDING THOSE OF FITNESS FOR ANY PARTIC-
ULAR PURPOSE OR MERCHANTABILITY, ARE 
HEREBY DISCLAIMED AND IF APPLICABLE, IM-
PLIED WARRANTIES UNDER ARTICLE 35 OF THE 
UNITED NATIONS CONVENTION ON CONTRACTS 
FOR THE INTERNATIONAL SALE OF GOODS. 

Some national, state, or local laws do not allow limi-
tations on implied warranty or how long an implied 
warranty lasts, so the above limitation may not apply 
to you.

5. EXCLUSIONS

The following are excluded from the warranty cover-
age: 

(1) periodic maintenance and repair or replacement 
of parts due to normal wear and tear; 

(2) batteries; 

(3) finishes; 

(4) installations or defects resulting from installa-
tion; 

(5) any damage caused by (i) shipping, misuse, 
abuse, negligence, tampering, or improper use; (ii) 
disasters such as fire, flood, wind, and lightning; (iii) 
unauthorized attachments or modification; 

(6) service performed or attempted by anyone other 
than an authorized Ashtechs Service Center; 

(7) any product, components or parts not manufac-
tured by Ashtech, 

(8) that the receiver will be free from any claim for 
infringement of any patent, trademark, copyright or 
other proprietary right, including trade secrets 

(9) any damage due to accident, resulting from inac-
curate satellite transmissions. Inaccurate transmis-
sions can occur due to changes in the position, 
health or geometry of a satellite or modifications to 
the receiver that may be required due to any change 
in the GPS. (Note: Ashtech GPS receivers use GPS or 
GPS+GLONASS to obtain position, velocity and time 
information. GPS is operated by the U.S. Govern-
ment and GLONASS is the Global Navigation Satel-
lite System of the Russian Federation, which are 
solely responsible for the accuracy and maintenance 
of their systems. Certain conditions can cause inac-
curacies which could require modifications to the re-
ceiver. Examples of such conditions include but are 
not limited to changes in the GPS or GLONASS trans-
mission.).

Opening, dismantling or repairing of this product by 
anyone other than an authorized Ashtech Service 
Center will void this warranty.

6. EXCLUSION OF INCIDENTAL OR CONSEQUEN-
TIAL DAMAGES

ASHTECH SHALL NOT BE LIABLE TO PURCHASER 
OR ANY OTHER PERSON FOR ANY INDIRECT, IN-
CIDENTAL OR CONSEQUENTIAL DAMAGES WHAT-
SOEVER, INCLUDING BUT NOT LIMITED TO LOST 
PROFITS, DAMAGES RESULTING FROM DELAY OR 
LOSS OF USE, LOSS OF OR DAMAGES ARISING 
OUT OF BREACH OF THIS WARRANTY OR ANY IM-
PLIED WARRANTY EVEN THOUGH CAUSED BY 
NEGLIGENCE OR OTHER FAULT OFASHTECH OR 
NEGLIGENT USAGE OF THE PRODUCT. IN NO 



EVENT WILL ASHTECH BE RESPONSIBLE FOR 
SUCH DAMAGES, EVEN IF ASHTECH HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAG-
ES.

Some national, state, or local laws do not allow the 
exclusion or limitation of incidental or consequential 
damages, so the above limitation or exclusion may 
not apply to you.

7. COMPLETE AGREEMENT

This written warranty is the complete, final and ex-
clusive agreement between Ashtech and the pur-
chaser with respect to the quality of performance of 
the goods and any and all warranties and representa-
tions. THIS WARRANTY SETS FORTH ALL OF 
Ashtech'S RESPONSIBILITIES REGARDING THIS 
PRODUCT. 

THIS WARRANTY GIVES YOU SPECIFIC RIGHTS. 
YOU MAY HAVE OTHER RIGHTS WHICH VARY 
FROM LOCALITY TO LOCALITY (including Directive 
1999/44/EC in the EC Member States) AND CER-
TAIN LIMITATIONS CONTAINED IN THIS WARRAN-
TY MAY NOT APPLY TO YOU.

8. CHOICE OF LAW.

This limited warranty is governed by the laws of 
France, without reference to its conflict of law provi-
sions or the U.N. Convention on Contracts for the In-
ternational Sale of Goods, and shall benefit Ashtech, 
its successors and assigns.

THIS WARRANTY DOES NOT AFFECT THE CUS-
TOMER'S STATUTORY RIGHTS UNDER APPLICA-
BLE LAWS IN FORCE IN THEIR LOCALITY, NOR 
THE CUSTOMER'S RIGHTS AGAINST THE DEALER 
ARISING FROM THEIR SALES/PURCHASE CON-
TRACT (such as the guarantees in France for latent 
defects in accordance with Article 1641 et seq of the 
French Civil Code).

For further information concerning this limited war-
ranty, please call or write:

Ashtech SAS - ZAC La Fleuriaye - BP 433 - 44474 
Carquefou Cedex - France.

Phone: +33 (0)2 28 09 38 00, Fax: +33 (0)2 28 09 
39 39
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Introduction to FAST Survey

FAST Survey is a software program intended for advanced 
land surveying. FAST Survey can be used with the following 
Ashtech GNSS receivers:
• ProMark 800
• ProMark 200, ProMark 100
• ProMark 500, ProFlex 500
• Z-Max, ProMark 3 RTK

In its standard version, FAST Survey allows you to perform the 
following types of surveys.
• Logging positions of points in the coordinate system used. 
• Staking out points, straight lines and curves, with or 

without offset, while providing the specific information 
needed as you do that, including cut and fill information 
(in 3D).

• Logging GNSS raw data (post-processed projects or as 
backup to real-time RTK projects).

• Entering attributes, based on feature code lists, as you 
store new points, in a way much similar to GIS mobile 
software.

FAST Survey includes various tools to assist surveyors in their 
projects. Some of these tools are listed below.
• Monitoring GNSS reception and current position status
• Writing notes to be appended to job files
• Creating and saving local coordinate systems through 

localization
• Setting height references (arbitrary, DTMs, etc.)
• GNSS utilities (Send command, reset RTK)
• Interfacing with total stations. FAST Survey can also 

support different peripherals as inputs (lasers, depth 
sounders) or outputs (light bars)

As software options, FAST Survey offers the following 
functions:
• Set of COGO tools
• ROAD tools, including a map editor to prepare maps for 

use as visual background information while surveying. 
This editor operates in a way much similar to an AutoCad 
editor.
1
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This Getting Started Guide only deals with FAST Survey’s 
basic functions. For more information on this program and its 
software options, see the FAST Survey Reference Manual.
2
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Installing FAST Survey

This section describes how to install FAST Survey from the CD 
provided, using an office computer. FAST Survey can also be 
downloaded from the Ashtech FTP server.
If Windows XP (or older OS version) is used on your computer, 
you first need to install Microsoft Active Sync on your office 
computer. 
If Windows Vista is used, you don’t normally need to install 
an additional program on your computer. However, if the 
installation of FAST Survey fails, you will have first to install 
Windows Mobile Device Center and then resume the 
installation of FAST Survey.
The latest versions of ActiveSync and Device Center can be 
downloaded from http://www.microsoft.com/windowsphone/
en-us/howto/wp6/sync/prepare-to-sync-windows-phone-6-5-
with-my-computer.aspx at no cost.
In the procedure described below, the term “data collector” 
is used equally to designate either a “pure” data collector 
(i.e. without embedded GNSS receptions capabilities) or a 
GNSS handheld such as the ProMark 100/200 or a 
MobileMapper 10).
Note that ProMark 100 or ProMark 200 may be used:
• Either as standalone RTK equipment using an external 

antenna and running FAST Survey for this purpose 
(typically ProMark 200)

• or as a simple data collector for ProMark 500 or ProMark 
800. In this case, the GNSS reception capabilities of the 
handheld are not used.

Installation
Procedure

• Connect the data collector to your office computer using 
the USB data cable provided. For ProMark 200 or 
ProMark 100, place the receiver on its docking station 
and connect the docking station to the computer through 
the USB cable.

• Turn on the data collector.
• Insert the FAST Survey CD in your office computer. This 

automatically starts the setup file stored on the CD.
• Click on the Install FAST Survey for... option corresponding 

to your equipment. This starts the FAST Survey Setup 
Wizard.

• Click Next>.
3
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• Check on the I accept the terms in the License Agreement 
option and then click Install.

• At the end of this phase, a message appears asking you to 
check the data collector screen to see if additional steps 
are needed to complete the installation.

• Click OK, then Finish to complete installation on computer 
side.

• On the data collector, the installation phase has 
automatically started. For ProMark 200 or ProMark 100, 
a message first appears asking you to choose the location 
where to install FAST Survey (the default “Device” option 
is recommended), then tap on Install to continue.
When the progress bar disappears from the screen, this 
means installation is complete. The FAST Survey icon can 
then be seen on the screen.
For ProMark 200 and ProMark 100, a message indicates 
that installation has been successful. Tap OK to go back 
to the screen where the FAST Survey command line and 
icon line will now be visible.
4
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Registering as a FAST Survey User

The first time you start FAST Survey, you will be prompted to 
register your license of the software. If you do not register, 
FAST Survey will remain in demo mode, limiting each job file 
to a maximum of 30 points.
FAST Survey registration is done via the Internet at the 
following address: 

www.survce.com/Ashtech

You will be asked to enter the following information:
• User Name
• Company Name
• Serial Number*
• Email Address
• Phone Number
• Fax Number
• Hardware ID#1*
• Hardware ID#2*
• Reason for Install
• Registration Code*

*: Select Equip>About Fast Survey>Change Registration in FAST 
Survey to read this information.
After you submit this information, your change key will be 
displayed and emailed to the address that you submit. Keep 
this for your permanent records. You may then enter the 
manufacturer and model of your equipment.
If you do not have access to the Internet, you may fax the 
above information to (+1) 606-564-9525. Your registration 
information will be faxed back to you within 48 hours. During 
this time, you may continue to use the program without 
restriction. After you receive your Change Key, enter it and tap 
OK. You can then create a new FAST Survey job, as explained 
further.

http://update.carlsonsw.com/decode_xml.php?reg_type=dc&prod_name=Ashtech%20Fast%20Survey
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Creating a New FAST Survey Job

1. Turn on the data collector and wait until the boot 
sequence is complete.

2. Make sure the clock is set properly before starting FAST 
Survey.

3. Tap on “FAST Survey” on the Today screen to launch FAST 
Survey.

4. Tap the Select New/Existing Job button. This opens the 
Coordinate Files window.

5. Tap on the highlighted “crd” file name located at the 
bottom of the screen. This opens FAST Survey’s virtual 
keyboard with the file name now appearing above.

6. Using the keyboard, type in the name of the “crd” file in 
which FAST Survey will store the data you will collect 
during your job.

7. Tap . This takes you back to the Coordinate Files 
window where your file name now appears in the Name 
field.

8. Tap  again. This opens the Job Settings window, which 
consists of five different tabs on which you can set a large 
number of parameters pertaining to the job (or future 
jobs). 
Only the parameters that make sense with a GNSS system 
are presented below. All other parameters should be kept 
with their default settings. 
On the System tab:
– Distance: Choose the unit in which all measured 

distances will be expressed (US Survey Feet, Metric or 
International Feet). Unless “Metric” is selected, you 
can also choose the units in which distances will be 
displayed (“Decimal feet” or “Inches”). Warning! You 

cannot change this setting after creating the file!

– Angle: Choose the unit in which all measured angles 
will be expressed (degrees, minutes, seconds or grads)

– Zero Azimuth Setting: Choose the direction for which 
azimuth is arbitrarily set to 0° (North or South)

– Projection: Choose a projection from the combo box. To 
select a different projection, tap the Edit Projection List 
button. The Add Predefined button allows you to select 
an existing projection. The Add User Defined button 
allows you to create an entirely new projection. The 
6
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selected or created projection will then be selectable 
from the combo box.

On the Stake tab:
– Precision: Choose the number of decimal places (0 to 

5) used to express the three coordinates of any 
stakeout point. “0.000” (3 decimal places) is the best 
setting to fully benefit from the precision offered by 
your equipment.

On the Format tab:
– Coordinate Display Order: Choose the order in which you 

want FAST Survey to display East and North 
coordinates (East, North or North, East).

– Angle Entry and Display: Choose the type of angle FAST 
Survey will display (Azimuth or Bearing).

9. Tap . This creates the file, closes the Job Settings 
window and takes you to the FAST Survey menu.
7
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Configuring a ProMark 200 or ProMark 100 RTK Rover

Prerequisites • Your rover is properly set up (ProMark 200 or 100 
handheld connected to an external GNSS antenna placed 
on top of a pole) and powered on. 

• FAST Survey is running on the rover and a job file is open.

Set Tracking Mode
Using GNSS

Toolbox

First use the GNSS Toolbox utility to set the tracking mode of 
the receiver. FAST Survey will only be able to work from the 
signals selected with this utility.
Running GNSS Toolbox from within FAST Survey is simply 
done by selecting Equip > GPS Utilities > GNSS Toolbox > GNSS 
Settings. Select the desired tracking mode option. You can 
also set the elevation mask and enable or disable the use of 
SBAS.

Set Receiver and
Antenna

• In FAST Survey, tap on the Equip tab and then on the GPS 
Rover button. A message may appear asking you to 
confirm your choice of configuring a rover. Tap Yes. This 
opens the Current tab of the GPS Rover window.

• The Manufacturer and Model fields should normally have 
been set to the right values on launching FAST Survey:
– Manufacturer: “Ashtech”
– Model: “ProMark 100/200”

Note that the  button beside the Manufacturer field 
allows you to read the following information about the 
connected receiver:
– Firmware version
– Receiver ID
– Power status
– Free memory space
– Firmware options installed.

Tap on  to return to the Current tab.
• Tap on the Receiver tab.

• Tap on to define the external antenna used.
• Find the antenna model used (default: ASH111661) in 

the Part Number scroll-down menu.
8
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• Tap  to choose this antenna and close the window. The 
chosen antenna model can now be seen on the Receiver 
tab. The value in mm on the right refers to the vertical 
distance between the top of the pole (or the base of the 
antenna) and the L1 phase center of the selected 
antenna. 

• Select the Vertical option for the antenna height 
measurement.

• Tap within the Antenna Height field and enter the value you 
have measured or read for the range pole length.

• Choose your preferred setting for Elevation Mask, (default: 
5°)

• Store Vectors in Raw Data: Enable this option if you want to 
save all vectors to the job file (the crd file). Keep it cleared 
otherwise.

• Advanced Button: Provides access to the following 
settings:
– Ambiguity Fixing (see table below).

– Use SBAS, Use GLONASS: Using SBAS and/or 
GLONASS satellites helps to maintain the availability 
of fixed positions in those difficult environments where 
GPS alone would fail to do so.
IMPORTANT! Activating the Use GLONASS option will 
be effective on GLONASS reception only if you have 
previously set the Tracking mode parameter in GNSS 
Toolbox to “GPS L1+GLONASS L1”. See Set Tracking 
Mode Using GNSS Toolbox on page 8. As for the Use 
SBAS option, only the last setting made is effective, 
whether you do it from GNSS Toolbox or from FAST 
Survey.

– The Virtual Antenna option is disabled by default. 
Enabling the virtual antenna, which is defined as the 
generic “ADVNULLANTENNA” GNSS antenna, allows 
all collected data to be decorrelated from the GNSS 
antenna actually used at signal reception level. This 
may be useful if you wish to post-process the collected 
raw data using base raw data collected with a base 
from another manufacturer.

Choice Definition

Float
Choose this option if you only need decimeter accuracy (posi-
tion status will never go to “Fixed”).

95.0 95% confidence level
99.0 99% confidence level (default and recommended setting)
99.9 99.9 confidence level
9
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– Send file after config: You may have your receiver 
executing a number of additional commands 
(proprietary commands of the “$PASH” type) when 
later you tap on  to configure the receiver. These 
commands must have been saved to a text file, for 
example to a file created using Equip > GPS Utility > 
Send command. To select the file you want the receiver 
to execute when being configured, tap on the blue 
button and highlight the corresponding file name.

– NMEA Output Port: You may ask the rover to output one 
or more NMEA messages (GGA, GLL, RMC, VTG, GSV, 
GSA, ZDA, GST) on the specified output port 
(Bluetooth or port A). Once you have defined the 
output port (common to all NMEA messages), tap on 
the Configure button and then, for each desired NMEA 
message, select its output rate (in Hertz or seconds).

Once this is done, tap on  to enable all your NMEA 
messages, and on the same button again to validate all 
the advanced parameters.

Set Data Link
• Tap on the RTK tab. This tab allows you to set the data link 

on the rover side, in accordance with the base or network 
you will be working with. Several configurations are 
possible:
1. Using the internal cellular modem for a network 

connection (Direct IP, NTRIP or SpiderNet).
2. Using the internal cellular modem in CSD mode for a 

“phone call” type connection with the base (Direct 
Dial).

3. Using an external device (for example an external 
corrections receiver).

4. Using an external radio receiver (several radio models 
are possible).

• To use the cellular modem, select “Internet/Phone” as the 
Device used.

• Tap on  after the Device field to access the modem’s 
Auto Dial setting.
With this option enabled, the connection to the last base 
used (CSD mode), to the last mount point used (NTRIP), 
or to the last IP address used (Direct IP) will be 
automatically re-established after a power cycle.
10
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• Tap  to return to the RTK tab after making your choice 
for Auto Dial.

• Use the Network field to define the type of connection you 
want to establish through the internal modem.

Then use the visible  buttons accordingly.
11
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The tables below summarize all the settings required for 
each type of connection:

• Tap  to initiate the connection. Use the Monitor/Skyplot 
function to check that the receiver is set to operate in RTK 
mode. See Checking For a “Fixed” Position Solution 
Before Starting an RTK Project on page 28.

Parameters
TCP/IP 
Direct

NTRIP SpiderNet
Direct 
Dial

Base ID
(See sub-parameters below)

• • •

Broadcaster Name
(See sub-parameters below)

•

Station Name
(from source table)

•

Send Rover Pos? •

Sub-
Parameters

Base ID (TCP/
IP Direct)

Broadcaster 
Name (NTRIP)

Base ID 
(SpiderNet)

Base ID 
(Direct Dial)

Name • • • •

IP Address • • •

Port • • •

User Name • •

Password • •

Phone Number •

Send Rover 
Pos?

• • •
12
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Configuring a ProMark 800 RTK Rover or RTK Base

How FAST Survey
Interfaces With
Your Equipment

Via Bluetooth

First-Time Use
Right after you start FAST Survey and create or open your first 
job, FAST Survey will activate the previous connection to the 
receiver, if that is possible.
Assuming your base and rover are nearby and powered on, 
follow the procedure below to perform a Bluetooth connection 
with the base.
• Tap Equip>GPS Base.
• On the Current tab, select “Ashtech” from the Manufacturer 

drop-down list, and “ProMark 800” from the Model drop-
down list.

• Tap on the Comms tab.
• Select “Bluetooth” from the Type drop-down list 

and“Windows Mobile” from the Device drop-down list.

• Tap on . This opens the Bluetooth Devices window.
• Tap Find Receiver. Wait until FAST Survey lists the 

Bluetooth identifiers of your base and rover. The list 
appears in a new window.

• Highlight the Bluetooth identifier corresponding to the 
base. To make sure you select the right identifier, press 
the Scroll button on the base until you display the 
Receiver Identification screen. The identifier is in the 
lower line (after the “BT:” prefix).

• Tap . This takes you back to the previous screen where 
the selected Bluetooth identifier remains highlighted in 
the list. The following actions may be performed on the 
selected receiver using the following buttons:
• Set Receiver Name: By default, the “Receiver Bluetooth 

Identifier” of the detected receiver is assigned to this 
parameter. You may use a more self-explanatory name 
to identify your base (e.g.: “MyBase”). 

• Set Receiver PIN: Do not use this button. In its default 
configuration, your equipment does not request a PIN 
code to allow a peripheral device to connect to it via 
Bluetooth.

• Delete Receiver: Removes the selected receiver from the 
list of remote receivers detected by Bluetooth. 
13
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• Tap  to connect the data collector to the base via 
Bluetooth and then configure the base according to your 
needs (see RTK Base Configuration on page 14).

• Later, you will establish a Bluetooth connection with the 
rover. The process will start when you tap Equip>GPS Rover 
to configure the rover. From the Comms tab, you will be 
able to access the Bluetooth Devices window and select 
the rover receiver from the list of remote receivers 
detected by Bluetooth, in the same way as you did for the 
base.

Switching Between Base and Rover
During a FAST Survey session, you can quickly change the 
receiver you are communicating with (provided the receiver 
you want to communicate with is within Bluetooth range). 

The  icon located in the upper-right corner of the FAST 
Survey window allows you to change receivers. Tap on this 
icon and then:
• Select GPS Base to switch to the base,
• Or select GPS Rover to switch to the rover.

NOTE: If you examine more carefully this icon, you will see 
that it changes aspect (base or rover icon) depending on 
which receiver is currently communicating with FAST Survey.
In addition, on the Equip menu, a small check box appears in 
the icon inside either the GPS Rover or GPS Base button to 
indicate which connection is active.

Subsequent Uses
In the next sessions of FAST Survey, the software will prompt 
you to re-activate the Bluetooth connection you last 
established in the previous session, or simply work without a 
connection. If you choose the first option, FAST Survey will 
automatically re-establish the connection, provided the 
concerned receiver is still on and within Bluetooth range. 

RTK Base
Configuration

Prerequisites
• Your base is properly set up and powered on. It is on its 

definitive location for the survey and the data collector is 
located at less than 10 metres from the base. 

• Your data collector is on, FAST Survey is running, a 
Bluetooth connection has already been configured (with 
the base; see How FAST Survey Interfaces With Your 
Equipment Via Bluetooth on page 13) and a job file is 
open.
14
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• In FAST Survey, tap on the Equip tab and then the GPS 
Base button. A message may appear asking you to confirm 
your choice of configuring a base. Tap Yes. This opens the 
Current tab of the GPS Base window.

Set Manufacturer & Model 
• Set the Manufacturer (“Ashtech”) and Model (“ProMark 

800”) of the equipment used as the base.
Note that the  button beside the Manufacturer field 
allows you to read the following information about the 
connected receiver:
– Firmware version
– Receiver ID
– Power status
– Free memory space
– Firmware options installed.

Tap on  to return to the Current tab.

Check/Change Bluetooth Connection
• Tap on the Comms tab. Since the Bluetooth connection 

was performed earlier, just check that FAST Survey is 
properly configured to communicate with the base. You 
should read:
• Type = “Bluetooth”
• Device = “Windows Mobile”
• Instr = should be set to the name you gave earlier to the 

base, as seen from FAST Survey Bluetooth.

Note that  located next to the Device field allows you 
to return to the Bluetooth Devices window through which 
you earlier configured the Bluetooth connection to the 
base (see How FAST Survey Interfaces With Your 
Equipment Via Bluetooth on page 13). Changes can be 
made now if necessary.

Set Receiver Parameters
• Using the HI measurement tool provided, perform a slant 

measurement of the antenna height (recommended).
• On the data collector, tap on the Receiver tab.
15
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• Select the Slant option for the antenna height 
measurement.

• Tap within the Antenna Height field and enter the value you 
have just measured.

• Choose your preferred setting for Elevation Mask.
• Tap on the Advanced button. Choose your preferred 

settings for Use SBAS, Use GLONASS and Use Galileo.
Using SBAS, GLONASS and/or Galileo satellites will help 
the rover maintain the availability of fixed positions in 
those difficult environments where GPS alone would fail 
to do so.
The Virtual Antenna option is disabled by default. Enabling 
the virtual antenna, which is defined as the generic 
“ADVNULLANTENNA” GNSS antenna, allows all 
broadcast differential data and recorded raw data to be 
decorrelated from the GNSS antenna actually used at 
signal reception level. This may be useful when a rover 
from another manufacturer, which does not know the type 
of antenna used at the base, needs to receive RTK 
corrections from this base. 

• Send file after config: You may have your receiver executing 
a number of additional commands (proprietary commands 
of the “$PASH” type) when later you tap on  to 
configure the receiver. These commands must have been 
saved to a text file, for example to a file created using 
Equip > GPS Utility > Send command. To select the file you 
want the receiver to execute when being configured, tap 
on the blue button and highlight the corresponding file 
name.

• NMEA Output Port: You may ask the base to output one or 
more NMEA messages (GGA, GLL, RMC, VTG, GSV, GSA, 
ZDA, GST) on the specified output port (Bluetooth or port 
A). Once you have defined the output port (common to all 
NMEA messages), tap on the Configure button and then, 
for each desired NMEA message, select its output rate (in 
Hertz or seconds).

Once this is done, tap on  to enable all your NMEA 
messages, and on this button again to validate all the 
advanced parameters.

Set Data Link 
• Tap on the RTK tab. This tab allows you to set the data link 

on the base side. Several configurations are possible:
1. Using an external radio transmitter connected to 

ProMark 800’ port A (Satel, Ashtech U-Link, former 
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“Magellan” radio transmitter P/N 800986-x0, a 
license-free radio or PacCrest PDL or ADL), or using 
another external device connected to ProMark 800’s 
port A. The external device may be a radio transmitter 
from another manufacturer, or the local computer 
running the RTDS software.

2. Using ProMark 800’s internal modem for a network 
connection either in TCP/IP or UDP/IP protocol. When 
the internal modem is used, the receiver 
unconditionally uses its internal port E to deliver RTK 
corrections to the modem.

Using either of these devices to set the data link is 
explained below.
1. Setting an external radio or other device on port A (in 

all cases, parity is forced to “none” and stop bits to 
“1”):

Except for Satel, additional settings are required for all 
radio types.

These settings are accessible by tapping located 
next to the Device field, once you have selected one of 
these radios in the Device field. See below.
Satel: None

Selecting Radio Ashtech U-Link:

Radio type Possible Baud Rates

Satel 19200, 38400

Ashtech U-Link 38400 only

Magellan Radio (P/N 800986-x0) 19200 only

ARF7474A NA or ARF7474B EU 9600 only

Pacific Crest PDL or ADL
9600, 19200, 38400, 57600 or 
115200

Cable or Generic Device
(1200, 2400, 4800, 9600, 19200, 
38400, 57600 or 115200

Parameter Name Possible choices

Protocol
“Transparent” (recommended) or “DSNP”.
See also table below.
17
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The DSNP protocol should be used for the following 
transmitter-receiver combinations:

Magellan Radio (P/N 800986-x0), ARF7474B EU, 
ARF7474A NA:

PacCrest PDL:

Power Manage-
ment

“Automatic” or “Manual”.
“Automatic” is recommended.
In Automatic, the radio is automatically powered 
when you turn on the receiver and will only be 
turned off when you turn off the receiver. In Manual, 
the modem will be powered on only when you con-
figure the base

Channel Choose the channel used (channel No. - Frequency)

Squelch “Low”, “Medium” or “High”

Over the Air Baud “4800”,”7600” or “9600”. “9600” recommended.

Transmitter Receiver

800986-x0 U-Link Rx

800986-x0 PDL

U-Link TRx PDL

U-Link TRx TDRE (Z-Max)

Parameter Name Possible choices

Channel Choose channel used (channel No. - Frequency)

Parameter Name Possible choices

Protocol “Transparent” (recommended) or “Trimtalk”.

Channel
Choose the channel used (channel No. - Fre-
quency)

Over the Air Baud
“4800”, ”9600” or “19200”. “9600” recom-
mended.

Forward Error Correc-
tion

Enable or disable this function in the radio.

Scrambling Enable or disable this function in the radio.

Parameter Name Possible choices
18
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PacCrest ADL:

2. Using the internal modem (in all cases of use, internal 
port E is used, baud rate is forced to 19200 Bd, parity 
to “none” and stop bits to “1”),:
Select “Internal GSM” from the Device field. Choose 
the type of network connection desired using the 
Network field just underneath (selecting “None” means 
you keep the modem idle while still allowing base data 
to be generated in the selected format; see further 
below).
Tap on located next to the Device field to access 
the settings of the internal modem. The modem 
settings are listed in the table below:

Parameter Name Possible choices

Protocol
“Trimtalk”. “Transparent”, “Satel”, “TriMarkII/
IIe”, “TRIMMARK3”, “TT450S” or “Transparent 
FST”

Power 100 mW, 500 mW, 1 W, 2 W or 4 W

Channel
Choose the channel used (channel No. - Fre-
quency)

Over the Air Baud “4800”,  “9600”, “19200”, “8000” or “16000”.

Forward Error Correc-
tion

Enable or disable this function in the radio.

Scrambling Enable or disable this function in the radio.

Field Setting

Power
Manage-
ment

“Automatic” is recommended. In Automatic, the modem is 
automatically powered when you turn on the receiver and 
will only be turned off when you turn off the receiver. In 
Manual, the modem will be powered on only when you 
configure the base.

Band
Select the frequency band used for GSM communications 
in the country where you are. 

Provider

If you choose Network=” TCP/IP Network” or Net-
work=”UDP/IP Network”, choose the name of your mobile 
communication provider in this field. There are three pre-
set providers: Cingular, T-Mobile and MoviStar. If you are 
using another provider, select “User” or “Other” in this field 
and then tap on the Settings button underneath to enter 
the parameters of your provider (APN server, APN User 
Name and APN Password).

Pin
Enter the Pin number of the SIM card inserted in your 
ProMark 800.

Dial Mode
“Analog” is usually the right selection at the base. Please 
call your communication provider for more information.
19
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If you chose Network=”TCP/IP Network” or “UDP/IP 
Network”, an accordingly named field appears further 
down on the screen allowing you to define the other 
end of the network connection (i.e. recipient IP 
address and port number) and name it at your 
convenience.

Tap on located next to the xxP/IP Network field to 
create and manage different network connections.

• Use the Message Type field to set the format in which base 
data messages will be generated: ATOM, ATOM compact, 
RTCM V3.0, RTCM V2.3, CMR or CMR+, (RTCM-DGPS).
When the Internal GSM is used and a TCP/IP network 
connection is active, this field is forced to “ATOM”.

• If a repeater is used within your system to extend the 
range of the UHF radios used, enable the Repeater Mode 
check box. Enabling this option causes the output rates of 
all the differential messages to be changed into an even 
value (2 sec.) in order to make them compatible with the 
use of the repeater.

• Tap  to load the settings to the radio or modem. This 
may take a few seconds. FAST Survey then returns to the 
GPS Base configuration window.

Load Configuration to the Base
Now that you have browsed all the tabs in the Base 
Configuration window and set all the parameters, just tap  
to connect and load the configuration to the base. This may 
take a few seconds.

Set Base Position
FAST Survey then asks you to set the base position. 
Depending on the chosen method, follow the instructions 
displayed on the screen to define this position (see also 
Setting the Base Position With FAST Survey on page 48 for 
more information). This completes the base configuration 
phase.

Auto Dial Keep this box disabled for a base.

2G/3G 
Mode

You may force the modem to work only in a 2G network or 
let it work either in a 2G or 3G network, depending on 
which network is available from the base location.

Field Setting
20
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RTK Rover
Configuration

Prerequisites
• Your rover is properly set up and powered on. 
• Your data collector is on, FAST Survey is running and a job 

file is open.
• In FAST Survey, tap on the Equip tab and then the GPS 

Rover button. A message may appear asking you to 
confirm your choice of configuring a rover. Tap Yes. This 
opens the Current tab of the GPS Rover window.

Set Manufacturer & Model 
• Set the Manufacturer (“Ashtech”) and Model (“ProMark 

800”) of the equipment used as the rover.
Note that the  button beside the Manufacturer field 
allows you to read the following information about the 
connected receiver:
– Firmware version
– Receiver ID
– Power status
– Free memory space
– Firmware options installed.

Tap on  to return to the Current tab.

Set Bluetooth Connection
• Tap on the Comms tab.
• In the Type field, select “Bluetooth”.
• In the Device field, select “Windows Mobile”.

• Tap on  to access the Bluetooth Devices window. The 
window lists Bluetooth identifiers that correspond to the 
receivers found in the vicinity.

• Select the rover’s Bluetooth identifier from the list. To 
make sure you are making the right selection, press the 
Scroll button on your rover until you display the Receiver 
Identification screen. The Bluetooth identifier is shown in 
the lower line. This is the parameter you must select from 
the list.
You may give the rover a more familiar name (e.g. 
“MyRover”) using the Set Receiver Name button. 

• Tap  to connect the data collector to the rover via 
Bluetooth. FAST Survey then returns to the GPS Rover 
configuration window.
21
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• Check that the rover name is now selected in the Instr 
field.

Set Receiver Parameters
• Measure or read the length of the range pole on top of 

which the ProMark 800 is mounted.
• On the data collector, tap on the Receiver tab.
• Select the Vertical option for the antenna height 

measurement.
• Tap within the Antenna Height field and enter the value you 

have just measured or read for the range pole length.
• Choose your preferred setting for Elevation Mask.
• Store Vectors in Raw Data: Enable this option if you want to 

save all vectors to the job file (the crd file). Keep it cleared 
otherwise.

• Advanced Button: Provides access to the following 
settings:
– Ambiguity Fixing (see table below).

– Use SBAS, Use GLONASS, Use Galileo: Using SBAS, 
GLONASS and/or, Galileo satellites helps to maintain 
the availability of fixed positions in those difficult 
environments where GPS alone would fail to do so.

– The Virtual Antenna option is disabled by default. 
Enabling the virtual antenna, which is defined as the 
generic “ADVNULLANTENNA” GNSS antenna, allows 
all collected data to be decorrelated from the GNSS 
antenna actually used at signal reception level. This 
may be useful if you wish to post-process the collected 
raw data using base raw data collected with a base 
from another manufacturer.

– Send file after config: You may have your receiver 
executing a number of additional commands 
(proprietary commands of the “$PASH” type) when 
later you tap on  to configure the receiver. These 
commands must have been saved to a text file, for 
example to a file created using Equip > GPS Utility > 
Send command. To select the file you want the receiver 
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Choice Definition

Float
Choose this option if you only need decimeter accuracy (posi-
tion status will never go to “Fixed”).

95.0 95% confidence level

99.0 99% confidence level (default and recommended setting)

99.9 99.9 confidence level
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to execute when being configured, tap on the blue 
button and highlight the corresponding file name.

– NMEA Output Port: You may ask the rover to output one 
or more NMEA messages (GGA, GLL, RMC, VTG, GSV, 
GSA, ZDA, GST) on the specified output port 
(Bluetooth or port A). Once you have defined the 
output port (common to all NMEA messages), tap on 
the Configure button and then, for each desired NMEA 
message, select its output rate (in Hertz or seconds).

Once this is done, tap on  to enable all your NMEA 
messages, and on the same button again to validate all 
the advanced parameters.

Set Data Link 
• Tap on the RTK tab. This tab allows you to set the data link 

on the rover side, in accordance with the base or network 
you will be working with. Several configurations are 
possible:
1. Using the internal radio receiver.
2. Using the internal modem for a network connection 

(TCP/IP, NTRIP or SpiderNet).
3. Using an external radio receiver connected to ProMark 

800’ port A (Satel, ARF7474B EU or ARF7474A NA).
Or using an external device also connected to this port 
(for example an external corrections receiver)

4. Using the data collector’s internal modem for a 
network connection (TCP/IP Direct, UDP/IP Direct, 
NTRIP or SpiderNet).

Using either of these devices to set the data link is 
explained below.
1. Setting the internal radio receiver (“Internal ADL”): 

(internal port D used at 38400 Bd, parity=None, Stop 
Bits=1)

Additional settings are accessible through located 
next to the Device field, once you have selected 
“Internal ADL” in the Device field. See below.
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Then tap  to load the settings to the radio. This may 
take a few seconds. FAST Survey then returns to the 
GPS Rover configuration window.

2. Using ProMark 800’s internal modem (in all cases of 
use, internal port E is used, baud rate is forced to 
19200 Bd, parity to “none” and stop bits to “1”):
Select “Internal GSM” from the Device field. Choose 
the type of network connection desired using the 
Network field just underneath (selecting “None” means 
you keep the modem idle).

Tap on  next to the Device field to access the 
settings of the internal modem. The modem settings 
are listed in the table below:

Parameter 
Name

Possible Choices

Protocol

Match the choice of protocol to the one made at the 
base. Available protocols: Trimtalk, Transparent, Satel, 
TrimMarkII/IIe, TRIMMARK3, TT450S or Transparent 
FST.

Power Man-
agement

“Automatic” is recommended. In Automatic, the radio 
module is automatically powered when you turn on the 
receiver and will only be turned off when you turn off the 
receiver. In Manual, the module will be powered on only 
when you configure the rover.

Channel Choose the channel used (Channel No. - Frequency)

Squelch

The factory default setting of “High” provides maximum 
effective sensitivity to incoming signals.This is the pre-
ferred setting.
“Medium” and “Low” sensitivity settings are available for 
use if local electrical noise or distant radio signals 
falsely activate the radio receiver. Use of these settings 
may reduce the radio range.

Over the Air 
Baud

Five possible baud rates: 4800, 9600, 19200, 8000 or 
16000.

Scrambling
Set this parameter as set at the base if it uses a Pacific 
Crest transmitter. For another radio used at the base, 
keep this option disabled.

Forward 
Error
Correction

Set this parameter as set at the base if it uses a Pacific 
Crest transmitter. For another radio used at the base, 
keep this option disabled.
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If you choose Network= “NTRIP”, then, tap on  
next to the Network field, for additional settings (NTRIP 
broadcaster name, IP address, port, username and 
password).

Then tap  to validate your new settings and load the 
source table from the NTRIP provider. This takes you 
back to the RTK tab. Further down on the screen, in the 
NtripInfoCaster field, select one of the stations returned 
by the NTRIP provider as the base station you want the 
rover to work with.

If you tap on  next to this field, you will see the 
properties of the selected station (identifier, message 
format, position, etc.)
If you choose Network= “TCP/IP Direct” or 
“SpiderNet”, then a Base ID field appears further down 
on the screen in which you can select the name of the 
base station you want the rover to work with.

Field Setting

Power
Manage-
ment

“Automatic” is recommended. In Automatic, the modem is 
automatically powered when you turn on the receiver and 
will only be turned off when you turn off the receiver. In 
Manual, the modem will be powered on only when you con-
figure the rover. “Automatic” is mandatory if “Auto Dial” is 
enabled.

Band
Select the frequency band used for GSM communications 
in the country where you are. 

Provider

Choose the name of your mobile communication provider 
in this field. There are three preset providers: Cingular, T-
Mobile and MoviStar. If you are using another provider, 
select “User” or “Other” in this field and then tap on the Set-
tings button underneath to enter the parameters of your 
provider (APN server, APN User Name and APN Pass-
word).

Pin
Enter the Pin number of the SIM card inserted in your Pro-
Mark 800.

Dial Mode
Depending on the provider, this may be “Analog” or “Digi-
tal”. “Analog” is usually the right selection. Please call your 
communication provider for more information

Auto Dial
Check this box if you wish that after a power cycle, the 
receiver can connect automatically to the last used NTRIP 
mount point or last used Direct IP server.

2G/3G 
Mode

You may force the modem to work only in a 2G network or 
let it work either in a 2G or 3G network, depending on 
which network is available from the rover location.
25



E
n
g
lish
If the Base ID field is blank, tap on  next to this 
field and enter the properties of one or more of these 
stations: Name, IP address, IP port (+username and 
password for SpiderNet). Then tap  to validate the 
new station and return to the RTK tab. Select the name 
of the new station in the Base ID field.

3. Using an external radio receiver or other device 

connected to ProMark 800 ‘s port A (in all cases, parity 
is forced to “none” and stop bits to “1”):

Except for Satel, additional settings are required for all 
radio types.

These settings are accessible by tapping located 
next to the Device field, once you have selected one of 
these radios in the Device field. See below.
Satel: None
ARF7474B EU, ARF7474A NA:

4. Using the cellular modem of a mobile phone: Select 
“Data Collector Internet” in the Device field, then 
select the type of network connection you wish to use 
(TCP/IP Direct, UDP/IP Direct, NTRIP or SpiderNet). 
Use the “Data Collector Internet” option to operate in 
a CDMA mobile network. This requires a Bluetooth 
connection between the data collector and the mobile 
phone.

If you choose Network= “NTRIP”, then tap on  
next to the Network field, for additional settings (NTRIP 
broadcaster name, IP address, port, username and 
password). 

Then tap  to validate your new settings and load the 
source table from the NTRIP provider. This takes you 
back to the RTK tab. Further down on the screen, in the 
NtripInfoCaster field, select one of the stations returned 

Radio type Possible Baud Rates

Satel 19200, 38400

ARF7474A NA or ARF7474B EU 9600 only

Cable or Generic Device
1200, 2400, 4800, 9600, 19200, 
38400, 57600 or 115200

Parameter Name Possible choices

Channel Choose channel used (channel No. - Frequency)
26
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by the NTRIP provider as the base station you want the 
rover to work with.

If you tap on  next to this field, you will see the 
properties of the selected station (identifier, message 
format, position, etc.)
If you choose Network= “TCP/IP Direct”, “UDP Direct” 
or “SpiderNet”, then a Base ID field appears further 
down on the screen in which you can select the name 
of the base station you want the rover to work with.

If the Base ID field is blank, tap on  next to this 
field and enter the properties of one or more of these 
stations: Name, IP address, IP port (+username and 
password for SpiderNet). Then tap  to validate the 
new station and return to the RTK tab. Select the name 
of the new station in the Base ID field.

• Send Rover Position to Network: Depending on the network/
station you selected, you may have been asked to return 
the rover position before the station can deliver its 
corrections through the data link. If that was so, then 
enable this function, otherwise keep it disabled.

• Tap  to load the settings to the radio or modem. This 
may take a few seconds. FAST Survey then returns to the 
GPS Rover configuration window.

Load Configuration to the Rover
Now that you have browsed all the tabs in the Rover 
Configuration window and set all the parameters, just tap  
to connect and load the configuration to the rover.
Use the Monitor/Skyplot function to check that the receiver is 
set to operate in RTK mode. See Checking For a “Fixed” 
Position Solution Before Starting an RTK Project on page 28.
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Checking For a “Fixed” Position Solution Before Starting an RTK 
Project

After the data link has been established, the rover starts 
acquiring corrections data from the selected source. Note 
that the rover will automatically recognize the format of the 
received data (ATOM, RTCM2.3, RTCM 3, CMR, CMR+, 
DBEN). Do the following before starting your survey:
• In the Equip menu, tap on the Monitor/Skyplot button
• Read the different parameters displayed on the screen. 

You should see the HRMS and VRMS rapidly decrease 
from a few meters to less than 10 to 20 mm, while the 
position status switches from “AUTO” to “FLOAT” and 
finally “FIXED”.

Other screens are available from within the Monitor/Skyplot 
function showing the details of the constellation, of the 
base position and of the RTK position solution:
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In NTRIP and Direct IP modes, a Disconnect/Connect 
button is available on the Quality tab to easily control the 
network connection. There is also a horizontal bar showing 
the GSM signal level.
In Direct Dial mode, a Hang up button is available on the 
same tab to terminate the connection with the base.

• Tap  after you have made sure the FIXED position 
status is settled. This takes you back to the FAST Survey 
menu from which you can start your survey.
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Using FAST Survey’s Basic RTK Functions

Uploading
Stakeout Points

In your office, do the following:
• Connect the receiver or data collector to your office 

computer using the USB data cable. For ProMark 200 or 
ProMark 100, place the receiver on its docking station 
and connect the docking station to the computer via the 
USB cable.

• Make sure ActiveSync is installed on your computer and is 
allowed to perform USB connections. If you do not have 
ActiveSync installed, download the latest version from the 
following web page:

http://www.microsoft.com/download/en/details.aspx?id=15

• Run GNSS Solutions on your office computer.
• Open the project containing the stakeout points you want 

to transfer to the receiver or data collector as your job.
• On the project map view, select all the reference and 

target points making up your job.
• Select Project>Upload Positions to External Device..

• Select RTK Job and FAST Survey data collector.
• Click OK.
• Name the job (e.g. MYJOB). Keep the Selected Targets and 

References option selected and click OK. This opens the 
Data Transfer dialog box.

• In the combo box, select Active Sync and keep Automatic 
transfer enabled.

• Click OK to establish the connection with the receiver or 
data collector and upload the job (to \My Device\Program 
Files\FAST Survey\Data\).

• After the job has been uploaded, turn off the receiver or 
data collector, disconnect the USB cable and go to the 
field with your surveying equipment to stake out your 
points.

Staking Out Points 1. Run FAST Survey and open the job containing the points 
you want to stake out.

2. Tap on the Survey tab and then select Stake Points. The 
screen now displayed allows you to stake out points.

3. On this screen, FAST Survey asks you to choose the point 
you want to stake out. You can either type in its 
coordinates in the Northing, Easting and Elevation fields, or 
30
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select a pre-defined point from the points list (see File> 
Points). You can also define graphically the point by 
tapping on the point on the graphic screen, or define the 
point according to azimuth, slope and horizontal distance.

4. Once you have chosen a point, tap . A graphic screen 
is now displayed to help you head for the point.

Name of 
stakeout point

Coordinates of 
stakeout point

Provides access to point list.
Example of points list:

Provides access to graphic screen

Zoom settings

Next stakeout point

Logs stakeout point

Current status of 
position solution

Name, coordinates of 
stakeout point, quality data, 
deviation data
(Use the up/down arrow 
keys to show/hide this 
information)

Takes you back to the 
point selection screen

Configures general 
case of point logging

Provides access to 
monitor screen

Provides access to 
screen below (Select 
“Text” in menu)

Your current position 
and heading

Stakeout point (target)

GNSS antenna height

Viewing parameters
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Yellow helmet gives
access to Function

Menu!

5. When the distance to the stakeout point is too small to be 
clearly seen on this screen, tap on the surveyor’s helmet 
in the upper-left corner and select Text from the menu that 
pops up.
A new screen appears giving a more accurate view of the 
remaining distance to the stakeout point. (If you want to 
return to the previous screen, just select Graph in the same 
menu.)

When the remaining distance is within the stakeout 
tolerance (this parameter can be changed in 
Equip>Tolerances), markers appear in the four corners of 
the target. You can now set a stake on this point.

6. Tap on the STORE button if you want to store the position 
of this point. You will be notified if the values of HRMS 
and VRMS exceed the tolerances set for these two 
parameters in Equip>Tolerances. A new screen is then 
displayed showing the coordinates of both the staked and 
design points. 

Stakeout point (target)

Provides access to 
previous screen
(Select “Graph” in menu)

Your current position 
and heading

Used to select which 
guidance data to display 
(underneath)

Used to select which 
guidance data to display 
for the point: coordinates 
or quality data

Current status of 
position solution
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7. Tap  if you agree. The “Point Stored” message appears 
briefly. The screen then comes back to the Stake Points 
screen where you can choose the next point to be staked.

8. After staking out all your points, tap  in the upper-
right corner of the screen to return to the menu.

Logging Points 1. Tap on the Survey tab and then on Store Points. The screen 
now displayed allows you to log all your points.
The figure below summarizes all the functions available 
from that screen.

2. Type in the point name and description in the 
corresponding two fields (see above)

Configures general 
case of point logging

Provides access to 
monitor screen

Your current position 
and heading

Graphic display area

GNSS antenna height

Viewing parameters
Zoom settings

Logging points with 
position averaging

Logging point 
with offset

Logging point 
(general case)

Enter point name 
and description in 
these two fields

Current position and 
related quality figures
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3. Tap on the “A” button
4. Enter the number of readings you want before FAST 

Survey is allowed to compute an average position for this 
point.

For example, type in “5” and tap .
Messages follow successively indicating that the system is 
taking the five requested readings. Then FAST Survey 
displays the average coordinates it has determined for the 
point.

5. Tap  if you agree. The “Point Stored” message appears 
briefly. The screen then shows the location of the point 
together with its name and description.

6. After logging all your points, tap  in the upper-right 
corner of the screen to return to the menu.

Logging a Line 1. On the Survey tab, select the Auto by Interval function. Two 
different modes are possible: Time or Distance.

2. If you choose Distance, enter the horizontal and vertical 
increment value respectively in the X/Y and Z fields, 
according to the chosen unit. If you choose Time, enter the 
increment value, in seconds.

3. Enter a point Id. for the start point in the Starting Pt ID 
field. This field will be incremented by one after each 
point logging. Initially, the Point Id. may only consist of 
letters (e.g. “ABCD”). FAST Survey will then increment 
the Point Id. as follows: ABCD1, ABCD2, etc.

4. Tap  to switch to the graphic screen (see figure below) 
and start logging the series of points along the line.
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The S button lets you instantly log the position of a point.
The pause button allows you to pause data logging in 
continuous mode.
If data logging in continuous mode is paused, you can still 
continue to log points in manual mode using the S button.
Tap the pause button again to resume data logging in 
continuous mode.

If you directly tap  to come back to the main menu, 
data logging in continuous mode is automatically stopped.

Downloading RTK
Points to GNSS

Solutions

• Go back to your office and connect the receiver or data 
collector to your office computer using the USB data 
cable. For ProMark 200 or ProMark 100, place the 
receiver on its docking station and connect the docking 
station to the computer via the USB cable.

• Run GNSS Solutions on your office computer.
• Open the project in which to add the points from the field.
• Select Project>Download Positions from External Device..

• Select RTK Results and FAST Survey data collector.
• Click OK. This opens the Data Transfer dialog box.
• In the combo box, select ActiveSync, enable Automatic 

Transfer and click OK. This opens a new window listing all 
the jobs stored in the data collector.

• Select the job you want to download (e.g. “MYJOB”) and 
click OK. This starts the download process.

Zoom settings

Configures general 
case of point logging

Provides access to 
monitor screen

Your current position 
and heading

Graphic display area

GNSS antenna height

Viewing parameters

Used to log a point’s 
position manually

Used to 
pause/resume data 
logging

Current status of 
position solution

Point ID incremented 
automatically

Current position and 
related quality figures
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Vector information relative to surveyed points is available only 
in .rw5 files. FAST Survey saves vector information directly in 
this file format and so does not create O-files that would 
contain such information.

Running
Localization in an

RTK Project

Choosing the Localization Method
• With your job open in FAST Survey, tap on the Equip tab 

and then on the Localization button. This opens the 
Localization window with the System tab shown first.
For your information, this tab shows the name of the 
projection selected earlier for the project (see File>Job 
Settings>System). Choosing another projection here would 
change the projection used in the job. It is your 
responsibility to have the right projection selected on 
which the localization process is going to be run.

• Tap on the GPS tab and select your localization methods 
for multi-point and one-point localizations. If you choose 
“Helmert” as the localization method, the one-point 
method selection is grayed.

One-Point or Multi-Point Localization
1. Tap on the Points tab. This tab allows you to define the 

reference points used as the input to the localization 
process.

For each of the available reference points, you need to 
enter the local coordinates and then the WGS84 
coordinates, as measured by your equipment.

List of reference points 
you want to include in the 
localization process

Edits the selected 
reference point

Deletes the selected 
reference  point

Adds a new reference 
point to the list

Loads a list of reference points 
from a DAT or LOC file

Controls the content of the selected row, in 
the points list above, where either the 
geographic or local coordinates of the 

reference point are displayed 

Enables/disables the selected 
reference point for/from the 
localization process

Saves the list of current 
reference points as a LOC or 
DAT file

Provides access to Solution 
Monitoring screen
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2. Tap Add to define the first reference point. A new window 
(Local Point) is displayed allowing you to do that. To add 
a reference point that already exists in the job, do one of 
the following:
• Type its name in the Point From File field. This 

automatically updates the window with the point’s 
local coordinates. 

• Or tap on the  button to access the list of points 
available. Choose one and tap the green button to 
return to the Local Point window. 

• Or tap on the  button to select the point directly 
on the map of the working area.

3. Tap on the green button ( ) to enter the name and local 
coordinates of the reference point.
FAST Survey then asks you to enter the WGS84 
coordinates of the point. Choose one of the following 
methods:
• Read GPS. Choosing this method means your 

equipment should be placed exactly over the reference 
point. Then enter a number of samples required before 
the equipment delivers an averaged WGS84 solution 
for the point (5 minimum recommended). Tap on the 
green button to let the equipment take the required 
readings and return a result (averaged position + 
residuals). Then validate the result. 

• Enter latitude/Longitude. Enter the three WGS84 
coordinates of the point, using the “dd.mmssss” 
format, for latitude and longitude. Elevation should be 
entered in the distance unit chosen for the job. Enter 
the orthometric elevation if a geoid file is used 
otherwise enter the ellipsoid elevation.

• From Raw File: Select a point from the job holding the 
WGS84 coordinates of the reference point. This point 
should have been surveyed earlier by the system in the 
same measurement conditions (same base setup, etc.) 
as now.

Once both the local and WGS84 coordinates have been 
entered, the reference point appears in the list of points 
used in the localization process.
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4. With the point selected in the list, tap on the On/Off button 
to tell FAST Survey how the point should be used in the 
localization process.
You can force the local grid to pass through its horizontal 
position by checking the Horizontal Control button and/or 
its vertical position by checking the Vertical Control button. 
Clearing the two options means the point is not involved 
at all in the localization process. Tap on the green button 
to validate your choices.

5. Resume the previous three steps until all your reference 
points have been added to the list.
As you add new points, check the amount of residual for 
each reference point involved in the localization (residuals 
are displayed in the lower part of the screen). The lower 
these values, the better the consistency of your set of 
reference points.
Should some residuals be abnormally high, the relevant 
point(s) should be deleted using the Delete button, or its 
contribution to the localization process changed by 
editing its control settings through the On/Off button.
If you enter only two reference points, the 2 pt Rotate Only 
button is made available. This option allows you to use the 
second point for direction but not for scaling.

6. Tap  when you are satisfied with the level of residuals. 
FAST Survey then asks you to save your list of points as a 
LOC or DAT localization file.

7. Name the file and tap . The localization process is 

now complete and active. This means every new point you 

will now survey will be expressed on the local grid.
If points have been surveyed in the job prior to the 
localization process, FAST Survey will prompt you to 
convert their coordinates to the new local grid. If you 
accept, FAST Survey will open the Process Raw File 
window.

Simply tap  to re-process the coordinates of these 
points. FAST Survey will return the list of converted 
coordinates.

NOTE: Tapping  from the Localization screen is 
mandatory to activate the new localization file. Using the 
Save button saves the localization file but does not make 
it active. 
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Helmert Localization
1. With your job open in FAST Survey, tap on the Equip tab 

and then on the Localization button.
2. Tap on the GPS tab and select “Helmert” from the Multi 

Point Method field.
3. Tap on the By Helmert tab and then enter the seven 

parameters defining the new datum of the local grid.

4. Tap . The localization process is now complete and 

active. This means every new point you will now survey will 
be expressed on the local grid.

Computing Helmert Parameters from a Multi-Point 
Localization File 
• Follow the instructions to perform a multi-point 

localization.
• After all the points have been defined, tap on the By 

Helmert tab.
• Tap on the Calc from Pts button. FAST Survey computes the 

seven Helmert parameters and displays the result in the 
corresponding fields.

• To save the seven parameters as a TXT file, tap on the 
Output to Text File button and name the file.

Using a Geoid File
in the Localization

Process

A library of geoids is available from the Ashtech website. 
Once you have downloaded the desired geoid, you need to use 
the Extract tool, also available and downloadable from the 
same web page, to convert the geoid into a GSF file, the only 
format FAST Survey can work from. The converted file can 
then be downloaded to the data collector through ActiveSync.
The details of the procedure are given below. Note that the 
Extract Tool can also be used to reduce the geographical 
extent of the geoid before you download it to the data 
collector. 

Downloading a Geoid to your Computer
• Use your office computer to go to the web page: http://

resources.ashtech.com/GEOIDS, 
• Select the desired geoid by clicking on the corresponding 

link. You are then prompted to save the 
Install_<Geoid_Name>.exe file on your computer.

• Click Save File and wait until the download is complete.
• Run the Install_<Geoid_Name>.exe file on your computer. 

Follow the instructions on the screen to complete the 
installation.
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If your data collector is currently connected to the 
computer via ActiveSync, instructions will also be 
provided to install the geoid file on the receiver as well (in 
\Program Files\Geoids Data\). Tap “No” in this case.

Installing the Extract Tool on your Computer
• Go back to the web page: http://resources.ashtech.com/

GEOIDS, 
• Click on Extract Tool located at the bottom of the menu in 

the left-hand part of the screen.
• Again, click on the Extract Tool link, now appearing at the 

bottom of the web page (you need to scroll down the 
page). You are then prompted to save the 
Install_Geoids.exe file on your computer.

• Click Save File and wait until the download is complete. 
• Run Install_Geoids.exe on your computer. Follow the 

instructions on the screen to complete the installation. 
Click on the Close button once complete.
 

Preparing the Geoid for Use in FAST Survey
• From the computer’s task bar, select Start>All 

Programs>Ashtech> Geoids.
• Select File>Open. The program opens directly the folder 

containing the downloaded geoid.
• Select it and click Open.
• Select File>Save, select “GSF File (*.gsf)” as the new file 

format, name the file and click Save. By default, the 
resulting GSF file is saved to the same folder on the 
computer.

• Copy the resulting GSF file to the ...\FAST Survey\Data\ 
folder on the receiver, using Microsoft ActiveSync.

Selecting a Geoid File for Use in FAST Survey’s 
Localization Process
In FAST Survey, do the following:
• In the Equip menu, tap on the Localization button.
• Tap on the GPS tab.
• Tap on the Geoid File: button. This opens the 

\MyDevice\FAST Survey\Data\ folder from which you can 
now select the geoid file you have just uploaded.

• Select the file and tap . The name of the geoid file now 
appears underneath the Geoid File: button, meaning that 
40
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from now on, it is used in the localization procedure for 
the processing of elevations.

Deselecting the Currently Used Geoid File
In FAST Survey, do the following:
• In the Equip menu, tap on the Localization button.
• Tap on the GPS tab.
• Tap on the Geoid File: button. This opens the 

\MyDevice\FAST Survey\Data\ folder.
• Select the file corresponding to the geoid currently used.

• Tap . This causes the geoid filename to disappear from 
underneath the Geoid File: button, meaning the geoid is no 
longer used in FAST Survey.
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Using FAST Survey’s Raw Data Collection Function

Collecting Raw
Data in Static or
Kinematic Mode

Collecting raw data with FAST Survey may be done in static 
or kinematic mode.
In Stop & Go kinematic, you may tag several points and mark 
the beginning and end of static occupations on these points. 
These events will be saved in the raw data file. When post-
processing the raw data file with GNSS Solutions, you will 
have to declare it as a kinematic observation.
1. Tap on the Survey tab and then on Log Raw GPS.
2. Tap on Start File. The screen lists the currently used 

settings. 
3. Keep or edit these settings:

• Elev Mask: Elevation mask, in degrees (default: 5 
degrees)

• Antenna Height: Current value of antenna height, 
expressed in the chosen unit. Use the Change Ant. 
button to change the antenna height. Choose the 
measurement type first (Vertical or Slant) and then enter 
the measured value.

•  Choose the storage medium where to store the file.
• Interval: Raw data recording rate, in seconds.

4. Tap . On top of the screen now appears the Logging... 
message indicating raw data recording in progress. A 
default name is given to the open raw data file, based on 
the ATOM naming conventions:

G<Site><Index><Year>.<Day>

Where “Site” is the name you last entered in the Site Name 
field below (this may be a bit confusing but you have to 
get used to it).
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5. Use the Tag New Site button to tag the raw data file with 
the name of the site (point or line) you are surveying:
• Site Name: Enter a four-character name (recommended) 

so that the entire name, and not a truncated name, can 
appear later in the raw data file name. Longer site 
names will not be truncated however in GNSS 
Solutions.
For a static observation (by a base or a rover), enter the 
name of the site where data collection takes place.
For a Stop & Go observation, enter a new name each 
time you arrive at a new point. This will later be 
interpreted as the beginning of a static occupation on 
this point. The end of the static occupation is 
controlled by the Stop Logging parameter below. 
For a continuous kinematic observation, enter the 
name of the line you are surveying.

• Site Attr.: Enter an optional description for the surveyed 
site.
[The antenna height and raw data recording rate 
(interval) are recalled on this screen. You can still 
change them if necessary.]

• Stop Logging: This parameter controls the end of the 
static observation on the specified point name (not to 
be confused with the end of raw data collection).
This control may be manual (you will decide by 
yourself when to stop: select Manually), or automatic, 
by selecting After and entering a preset duration, in 
minutes, for the observation on the point.
Typical durations in static are a day’s work for a base 
or several minutes or hours for a rover.
Typical durations in Stop & Go are several seconds to 
several minutes on each point.
In continuous kinematic, it makes sense to choose 
Manually because you do not know in advance how long 
it will take to get to the end of the line.
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6. Tap . A new screen is displayed summarizing all your 
settings.
• Site Duration: Shows the time elapsed since you started 

the observation on the point
• Time Remaining is displayed only if you have selected 

After (x minutes)
• Reminder on the antenna parameters used (height and 

type)
• Stop Point Logging: Tap on this button to stop the 

observation on the point (required if Manually was 
selected). if After (x minutes) was selected, tapping on 
this button will shorten the observation.

• Monitor/Satellite View button: May be used to make sure 
GNSS reception is good on the surveyed point (enough 
satellites are received, DOP values low). Ignore all 
RTK-related indicators. Note that making this check is 
not always compatible with short static occupation 
times on a point.

• Exit - Continue Logging button: Use this button if you 
change your mind and you no longer want to tag the 
point (and you want to continue logging the raw data 
file).

7. If you stop manually, you will be asked to confirm this. A 
message “Finished collecting data for this site (xx)” will 
then appear. In automatic, you will get this message 
directly.

8. Tap OK to close the message. This takes you back to the 
initial screen where you can see that raw data are still 
being collected.

9. Tap on the Close File button to end data collection and 
close the raw data file.

10.Tap on the File Manager button. You should recognize the 
last file in the list as the file you have just closed.

You may quit the Log Raw GPS function while letting FAST 
Survey collect raw data. In this case, you will have to confirm 
that you don’t want to close the raw data file.
When coming back to the Log Raw GPS function, again FAST 
survey will ask you what to do about the raw data file being 
currently logged.

Deleting Raw Data
Files

Use FAST Survey to delete raw data files from the receiver 
internal memory.
1. Tap on the Survey tab and then on Log Raw GPS.
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2. Tap on File Manager. The screen displays the following 
parameters:
• List of raw data filenames.
• Selected storage medium.
• Free memory available.
• Current number of raw data files in memory.

3. Unless already done, select Internal Mem to list the files 
stored in the internal memory.

4. To delete one file, highlight its name in the list and tap the 
Delete button. To delete all the files, tap Delete All Files.
Important! When the receiver is logging raw data, the file 
being logged cannot be deleted. The file is protected from 
deletion until you close it.
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Saving/Restoring Base and Rover Configurations 

FAST Survey allows you to save into a file all the settings you 
have prepared for your base or rover.
This function is useful when you regularly have to switch 
between two or more configurations. By simply selecting the 
right configuration, you immediately restore all the settings 
FAST Survey needs to load to the receiver before it can 
operate as expected.
The table below summarizes the parameters held in a 
configuration file.

For network connections, the file includes the provider’s 
connection parameters as well as, for NTRIP, the last 
reference station selected from the source table. Needless to 
say in these cases, you’ll really save time when starting your 
system if you first take a couple of seconds to save your 
configurations. 
FAST Survey manages base and rover configurations 
independently of job files. All saved configurations are 
potentially usable in all new jobs and whatever the existing 
jobs you re-open, provided the hardware available matches 
the configuration.
The two procedures described below apply to either a base or 
rover.

Saving a
Configuration

• Tap Equip then GPS Base for a base, or GPS Rover for a 
rover.

• Enter all the parameters needed to set the equipment in 
the tabs presented in this window.

Parameters Base Rover
Equipment manufacturer • •
Equipment model • •
Communication Type (Bluetooth or other) • •
Antenna height measurement type and value • •
Elevation mask • •
Ambiguity fixing •
Use SBAS satellites • •
Use GLONASS satellites • •
Use Galileo satellites • •
Use virtual antenna • •
NMEA outputs • •
Store vectors in raw data •
Device used in RTK data link and device settings • •
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• Before you tap  to load the configuration to the 
receiver, come back to the Current tab.

• Tap on the Save button located in the lower part of the 
window and then name the configuration (e.g. “Radio” or 
“NTRIP”).

• Name the configuration file and tap . This takes you 
back to the current tab where the new configuration is now 
listed.

Making a Saved
Configuration the

Current
Configuration

• Tap Equip then GPS Base for a base, or GPS Rover for a 
rover.

• Select the name of the desired configuration from the 
lower list.

• Tap on the Load button.
• Tap Yes to confirm your choice. This restores all the 

settings held in this configuration. You may check this by 
scrolling all the tabs in the window.

• Tap  to load the configuration to the receiver.
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Setting the Base Position With FAST Survey

Depending on how you chose the base site (is its position 
known or unknown?), choose either From Known Position, for 
known position, or From New Position, for unknown position. 
Then of the three possible choices, choose the one that suits 
your job.

Known Base
Position

Unknown Base
Position

Choice Case of Use

Previously Sur-
veyed Point

Choose this option if the base is installed on a point you sur-
veyed earlier and the latitude, longitude and ellipsoidal height 
of this point are saved in the open job. In this case, select this 
point from the job’s point list or select it graphically on the map 
of the working area.

Use Local Coor-
dinates

Choose this option if the coordinates of the point where the 
base is installed are known and expressed in the projection 
system used in the job.
You can enter the local coordinates either manually or by 
choosing a point from the job’s points list. In this case, and 
unlike the previous choice, the point from the points list is 
defined with local instead of geographical (lat, lon, height) 
coordinates.

Read from File
Choose this option if the geographical coordinates of the base 
were saved earlier to a REF file. Then select this file to load 
the position held in this file as the base position.

Choice Case of Use

Read from GPS

Choose this option if you want the base receiver to determine 
its own WGS84 coordinates.
The coordinates will be determined to within 1-3 meters as the 
autonomous GPS or S-DGPS mode is used in this case. To 
improve the accuracy of the computation, FAST Survey 
prompts you to take several readings (typically 10 readings or 
x readings over a certain period of time) so that all these read-
ings can be averaged to provide a more accurate position 
solution for the base.
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Enter Lat/Lon

Choose this option if you know and want to enter manually the 
latitude, longitude and ellipsoidal height of the base location, 
rather than ask the receiver to compute them by itself.
The coordinates should be entered in the “dd.mmssss” format 
for latitude and longitude.

Enter Grid Sys-
tem Coordinates

Choose this option to freely enter base coordinates expressed 
in the projection system used in the job. You may enter them 
manually or derive them from a point in the points list or a 
point you select on the map of the working area.

Choice Case of Use
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